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1 Introduction
1.1 Purpose
This is a user guide for the Herschel Scientific Mission Planning System (SMPS). It
explains how to configure the software and use it to perform the mission planning tasks
required for Herschel operations.
For further detailed information on the SMPS see the design documentation [RD10]. The
format of the files read by and generated by the SMPS is described in the relevant
Interface Control Documents [RD3, RD5, RD6, RD7, RD8 and RD11].
1.2 Preface
Please use the SMPS User Guide which is distributed with the HCSS. This is accessible
from the main HCSS documentation index. It will ensure that you have the latest
information relating to the version of the software you are using.
1.3 Reference Documents
[RD1]

"Herschel Mission Planning Concept", PT-HMOC-OPS-TN-6601-OPS-OGH.

[RD2]

"Herschel Ground Segment to Instruments Interface Control Document", FIRSTFSC-DOC-0200, issue 3.0, 15 October 2007.

[RD3]

"Planning Skeleton File ICD", PT-CMOC-FD-ICD-2104-OPS-GFT, HGSICD-017, issue 1.3, 24 July 2007.

[RD4]

"Scientific Mission Planning System - Pointing Modes", Herschel-HSCDOC-624, issue 2.2, 2 October 2007.

[RD5]

"Herschel Planned Observation Sequence (POS) Interface Control Document",
Herschel-HSC-ICD-0377, issue 1.6.

[RD6]

“Herschel/Planck orbital data and access software ICD”, PT-CMOC-FDICD-2101-OPS-GFI, HGS-ICD-020/HGS-ICD-027, issue 1.1, May 2007.

[RD7]

“ICD: Herschel Spacecraft / Instrument Alignment History”, PT-HMOC-FDICD-2111-OPS-GFT, HGS-ICD-026, issue 1.3, 7 February 2006.

[RD8]

“Solar System Object Ephemeris File ICD”, HERSCHEL-HSC-ICD-0566, HGSICD-022, issue 1.0, 13 February 2007.

[RD9]

“Scientific Mission Planning System – Pointing Modes”, Herschel-HSCDOC-624, issue 2.2, 2 October 2007.

[RD10] “Herschel Scientific Mission Planning System – Design Concepts and
Algorithms”, Herschel-HSC-DOC-741, issue 0.3, 21 May 2007.
[RD11] “Orbit Data Messages”, CCSDS Blue Book CCSDS 301.0-B-3 (see section on
OEM) Consultative Committee for Space Data Systems, January 2002.
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1.4 Acronyms
ACA

Attitude Control Axes

ACMS Attitude Control and Monitoring System
AOS

Acquisition Of Signal

APF

Attitude Parameter File

CUS

Common Uplink System

DEC

Declination

DTCP

Daily Telecommunications Period

EPOS

Enhanced Planned Observation Sequence

ESAC

European Space Astronomy Centre

ESOC

European Space Operations Centre

FD

Flight Dynamics

FDS

Flight Dynamics System

FIFO

First-In First-Out

FTS

File Transfer System

GUI

Graphical User Interface

HCSS

Herschel Common Science System

HOT

Herschel Operations Team

HSC

Herschel Science Centre

ICC

Instrument Control Centre

ICD

Interface Control Document

ICP

Instrument Command Parameter

ID

Identifier

JPL

Jet Propulsion Laboratory

L2

Second Lagrangian point

LEV

Long-term orbit Event file

LOF

Long-term Orbit File

LOS

Loss Of Signal

MGA

Medium Gain Antenna

MIB

Mission Information Base

MOC

Mission Operations Centre

MPS

Mission Planning System

NAIF

Navigation and Ancillary Information Facility

NNO

New Norcia
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OBSID Observation Identifier
OD

Operational Day

PHS

Proposal handling System

POS

Planned Observation Sequence

PSF

Planning Skeleton File

PST

Project Scientist Team

RA

Right Ascension

RMS

Reference Mission Scenario

SAA

Solar Aspect Angle

SCR

Software Change Request

SEV

Short-term orbit Event file

SIAM

Spacecraft Instrument Alignment Matrix

SMPS

Scientific Mission Planning System

SOF

Short-term Orbit File

SOPS

Spacecraft Operations (PSF window)

SPR

Software Problem Report

SSF

Schedule Summary File

SSO

Solar System Object

STR

Star Tracker

TBC

To Be Confirmed

TBD

To Be Defined

TOO

Target of Opportunity
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2 The Mission Planning Process
2.1 Overview of Planning Process
The Herschel Scientific Mission Planning System (SMPS) forms one part of an overall
mission planning process that involves both the Herschel Science Centre (HSC) and
Mission Operations Centre (MOC). This section outlines this complete process and the
role played by the SMPS. Additional information can be found in the Herschel Mission
Planning Concept document [RD1] and other documents referenced below.
The Herschel spacecraft operates autonomously for 21 hours each day, by executing a
daily schedule of telecommands that is uploaded once per day. This includes commands to
the Attitude Control and Monitoring System (ACMS) to manoeuvre the spacecraft,
commands to the scientific instruments to perform measurements and commands to
perform various engineering operations such as recycling the cryogenic cooler. The
purpose of the Scientific Mission Planning System (SMPS) is to generate these daily
schedules.
Communication with the ground station takes place in a 3-hour Daily Telecommunications
Period (DTCP), during which the spacecraft is manoeuvred to point its Medium Gain
Antenna (MGA) at the Earth. This period is used to uplink telecommands and downlink
the resulting telemetry from the previous day. In principle, scientific observations can be
performed during DTCP, but only a very limited part of the sky is visible during this time
because the antenna must be pointed within a few degrees of the Earth. Consequently,
DTCP is used to perform other activities, such as cooler recycling and biasing of the
reaction wheels; any remaining time can be used for scientific observations, if there are
suitable targets that do not violate the antenna constraint.
The spacecraft is in Lissajous orbit around the second Lagrangian point (L2) of the SunEarth-Moon system, at about 1.5 million kilometres from the Earth. This provides a stable
thermal environment, with a large part of the sky visible at any time. The Earth and Moon
constraints normally fall within the Sun constraint, such that the overall visibility remains
at around 50%. Another advantage of the L2 orbit is that the Sun constraint moves at only
about 1 degree per day. Hence the visibility constraints are almost constant throughout the
day.
As a result of the orbit around L2, the spacecraft is overhead the ground station when it is
approximately local midnight1. The 35m dish at the New Norcia ground station is used for
both Herschel and Planck, the order of the two DTCPs depending on their relative
positions in their orbits. Consequently, the Herschel DTCP may be earlier or later than the
overhead time.
For scheduling purposes, the mission is divided into operational days (OD) that cover the
period from the start of one DTCP to the start of the next. The duration of an operational
day is nominally 24 hours, but may vary depending on the ground station scheduling for
the two missions.
The spacecraft executes a continuous timeline, held in a First-In First-Out (FIFO) onboard buffer. This buffer has sufficient memory to hold the commands for two days and is
1

In the case of the nominal New Norcia ground station, this is approximately 16:15 UTC.
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topped-up with an uplinked schedule each day, so that it has enough commands for at least
24 hours. This ensures that the timeline will not run out even if a DTCP is missed due a
problem at the groundstation. In fact, the commands are uplinked in blocks of 24 hours,
running from the end of one DTCP to the end of the next, this being out of phase with the
Operational Days that run from the start of an OD. Consequently, if a DTCP is missed, the
on-board timeline extends long enough to cover the DTCP period during which the
commands are uplinked and there is never a break in the timeline.
The overall mission planning process starts with the generation of an orbit file by Flight
Dynamics (FD). A Long-term Orbit File (LOF) is delivered to the HSC once a month,
after trajectory optimisations, covering the remaining period to the end of the mission. A
more accurate Short-term Orbit File (SOF) is delivered once a week, after orbit
determinations, covering the following two months.
Based on the orbit information for both Herschel and Planck, FD generate a Short-term
Orbit Event File (SEV) and a Long-term Orbit Event File (LEV) [RD6]. These contain key
events such as the Acquisition Of Signal (AOS) and Loss Of Signal (LOS) for each of the
ground stations. This information allows FD to schedule the ground station allocation for
the two missions, which in turn determines the DTCP times and hence the time interval
covered by each OD.
The process continues with the generation of Planning Skeleton Files (PSF) [RD3], each
covering a single OD. The PSF is effectively an empty schedule that defines time
constraints on various operations, such as commanding the instruments and manoeuvring
the spacecraft. It also includes certain key event, such as AOS/LOS and the start/end of
DTCP. Spacecraft Operations (SOPS) windows are included to reserve time for MOC to
insert commands for orbit corrections, reaction wheel biasing, etc, when they receive the
completed schedule from the HSC.
The SMPS is used to add scientific observations and other activities to the schedule. When
the Mission Planner is satisfied with the schedule, he generates a Planned Observation
Sequence (POS) file [RD5] that expand the observations down to the level of individual
telecommands. The parameters of the telecommands are placed in a separate Instrument
Command Parameter (ICP) file, so that the POS file is shorter and easier to understand.
The POS contains pointing commands that invoke basic ACMS pointing patterns, such as
fine pointing, raster and line scan. More complex pointing modes are constructed using
these basic modes as building blocks. The complete set of pointing modes are described in
[RD9]. While the spacecraft is executing a pointing pattern, such as a raster, the
instrument is sent a sequence of telecommands, which must be carefully synchronised
with the sequence of spacecraft manoeuvres. This synchronisation is achieved by defining
the spacecraft and instrument commands for each observing mode in a single script which
is executed by the Common Uplink System (CUS).
Scheduling observation of moving Solar System Objects (SSO), such as planets, comets
and asteroids, makes use of ephemeris files that are obtained from the JPL Horizons
system. In addition, the SMPS uses a Spacecraft Instrument Alignment Matrix (SIAM)
[RD7] file that describes the alignment of the instrument boresights with respect to the
spacecraft X-axis. The SSO ephemeris files [RD8] and the SIAM files [RD7] are delivered
to MOC for information, although MOC do not currently use them.
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The Mission Planner prints a summary of the schedule and gives it to the Project Scientist
for approval. When it has been approved, the mission planner exports the schedule to
MOC for further processing and uplink. The POS and ICP files are combined in a wrapper
file and delivered to MOC using the Herschel File Transfer System (FTS). The FTS is also
used for transferring the orbit file, ephemeris files, SIAM files and PSF files.
When MOC receives the schedule, they insert various commands such as orbit correction
manoeuvres, into the SOPS windows reserved for them, and perform checks on spacecraft
constraints and slew times. As a result of this expansion and checking, the POS becomes
an Enhanced Planned Observation Sequence (EPOS) file and the ICP becomes an Attitude
Parameter File (APF). These form the the basis for uplink. If MOC encounter a problem,
they may notify the HSC and request that the affected days are replanned.
Each time the SMPS generates a POS/ICP, it commits the changes in the database and
marks the observations as 'scheduled' so that they are no longer available for scheduling in
subsequent ODs. The SMPS does not allow further changes to the schedule unless it is
first decommitted. This allows the OD to be replanned and releases the observations so
that they can be rescheduled. Decommitting a schedule requires a procedural interaction
with MOC to ensure that schedules are not changed once they have been uplinked to the
spacecraft or executed. It also requires authorisation from the Project Scientist. When a
schedule is replanned, it may affect the subsequent schedules. Consequently, a schedule
may only be decommitted if all the subsequent schedules are also decommitted.
The mission planning process is usually carried out on a weekly basis. MOC deliver a set
of seven PSFs at least 15 working days prior to uplink. The HSC delivers the
corresponding POS/ICP files back to MOC at least 10 days before uplink. This allows
time for up to two iterations if problems are encountered. A shorter turn-around is possible
in special cases, such as dealing with a Target Of Opportunity (TOO). A TOO may require
decommitting the affected schedule(s) and replanning.
2.2 Constraints
The Herschel spacecraft axes are shown in figure 1. Rotations about the X, Y and Z axes
are called “roll”, “pitch” and “yaw” respectively. The spacecraft orientation with respect to
the Sun is specified by a pair of angles “alpha” and “beta”:
•

Alpha is the angle between the Sun vector projected onto the spacecraft YZ plane
and the Z axis. It increases as the spacecraft rotates clockwise about its X axis.

•

Beta is the angle between the Sun vector projected onto the spacecraft XZ plane
and the Z axis. It increases as the spacecraft rotates clockwise about its Y axis (i.e.
As the telescope points further away from the Sun.
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X
Y

Z

Figure 1: Spacecraft axes
The scheduling of observations is subject to many temporal and spatial constraints. For
example:
•

Thermal and power considerations constrain the spacecraft XY plane (solar panel
and Sun shade) with respect to the Sun. The beta angle is constrained to ± 30º,
while the alpha angle is tightly constrained to ± 3º.

•

In order to reduce heating of the star-tracker, with consequent loss of pointing
accuracy, the beta angle should preferably not exceed +20º.

•

During DTCP, communications considerations constrain the Medium Gain
Antenna (MGA) (i.e. spacecraft +Z axis) to point within 15º of the Earth
(depending on the ground-station in use). Combined with the alpha (roll) angle
constraint, this translates into two roughly elliptical-shape constraints on the
pointing direction (+X axis).

•

In the PSF, MOC may reserve periods of time for spacecraft operations, such as
reaction wheel biasing and orbit correction manoeuvres.

•

Instrument considerations constrain the telescope (+X axis) direction with respect
to bright objects, including the Earth, Moon, Jupiter, Saturn and Mars. Normally,
the Earth and Moon constraints lie within the SUN constraint.

•

The Star Tracker (STR) points in the -X direction (i.e. in the direction opposite to
the telescope). The STR has a 20º constraint angle around the Moon, which
sometimes extends beyond the Sun constraint.

•

Observers may specify constraints on the time of scheduling, chopper avoidance
angle, map orientation, etc.

Some of these constraints are specified in the PSF file, whilst others are derived from orbit
and ephemeris calculations and some are given in individual observation requests.
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2.3 Instrument Scheduling
The Herschel spacecraft has three instruments, HIFI, PACS and SPIRE. However, for
mission planning purposes, each instrument is treated as a number of sub-instruments, as
follows:
HIFI

HIFI bands 1A,1B,2A,2B,3A,3B,4A,4B,5A,5B,6A,6B,7A,7B

P_PHOT

PACS photometry

P_SPEC

PACS spectrometry

S_PHOT

SPIRE photometry

S_SPEC

SPIRE spectrometry

PARALLEL

SPIRE/PACS parallel mode

Each Operational Day is typically assigned to a single sub-instrument in order to improve
efficiency. This reduces the overheads in switching between sub-instruments. In the case
of HIFI, several bands are often scheduled in an OD.
The largest overhead is recycling the liquid Helium cooler. The PACS and SPIRE
instruments each have their own cooler system, which requires recycling separately, each
taking about 3 hours. Once, recycled, the instrument can be used for two days. For PACS,
recycling is only needed for photometry and not for spectrometry.
For example, having spent three hours recycling the PACS cooler, it is most efficient to
perform only PACS photometry observations for the following two days. Similarly, after
recycling the SPIRE cooler, the following two days should be devoted to SPIRE. In
parallel mode, the PACS and SPIRE coolers can be recycled in parallel, taking about three
hours, after which parallel mode observations should be performed for two days.
Since the spacecraft attitude is severely constrained during the three-hour DTCP, this time
is less valuable for scientific observations. Consequently, it is a good time to recycle the
cooler and perform any other instrument preparation.
The other instrument preparation times are less significant than cooler recycling, but
nevertheless make it desirable to keep to one sub-instrument per day. For example,
preparing PACS for either photometry or spectrometry takes about 2000 seconds (each), in
addition to the cooler recycling time needed for photometry.
Instrument preparation operations, such as cooler recycling and detector curing, are known
as engineering observations, as they do not perform a scientific measurement. They are
scheduled like scientific observations but do not require any particular spacecraft attitude.
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3 Installation and Configuration
3.1 Hardware Requirements
It is recommended to run the SMPS on a Linux platform with 4 GB of memory (see
section 3.7). It should also be possible to run it on Solaris or Windows XP platforms, but
this has not been tested.
A three-button mouse is required. The screen size should be at least 20 inches with a
resolution of at least 1600x1200 pixels.
3.2 Installation
The SMPS is distributed as part of the Herschel Common Science System (HCSS). Please
see the HCSS installation instructions for general information. In addition, the SMPS
requires certain Java properties to be defined and certain data files to be present, as
explained below.
The following property should specify the HCSS installation directory:
var.hcss.dir = /local/software/hcss

3.3 Database
The following generic HCSS database property is required:
var.database.devel = database@hostname

The following property is set by default and should not normally be overridden:
hcss.mps.database = ${var.database.devel}

3.4 Site ID
For normal in-flight operations, using the system at the HSC, the following property
should be set:
hcss.ccm.siteid = 5

For multi-instrument IST tests, such as the Reference Mission Scenario (RMS), the value
should be 12. For SMPS installations at the ICC sites, the relevant site-specific value
should be used [RD2].
The purpose of this property is to initialize the observation counter to a site-specific value
(see section 3.8). This allows different sites to allocate unique numbers independently.
3.5 Data Directories
The SMPS requires a set of data directories to be defined. These contain the various files
used by and generated by the SMPS. Some of these files are also used by the Proposal
Handling System (PHS).
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A top-level data directory should be created that is pointed to by the Java property:
var.mps.datadir = /home/hsc/data

Within this directory, the following sub-directories should be created:
Directory

Example of Contents

orbit

H20070328_0001.SOE, H20070328_0001.LOE

psf

0080_0001.PSF

posicp

0080_0001.POS, 0080_0001.ICP

ssf

0080_0001.SSF

png

0080_0001.PNG

horizons

501

de405

ascp2007-2020.405

siam

0001_0001.SIAM

transfer/files

POS__HSCSDA_D_0080_0001_____00000.HERS

transfer/msg

pushPOS__HSCSDA_D_0080_0001_____00000.HERS

stpf

STPF_00000_2008109.csv

obdb

OBDB_4_0_B000_20080924.csv

Notes:
•

The PSF, POS, ICP, SSF, PNG and SIAM files have file names of the form
DDDD_VVVV.TTT, where DDDD is the OD number, VVVV is the version number and
TTT is a suffix denoting the file type. In the case of the SIAM file, the OD number
is simply the day on which the file was generated rather than the OD to which it
applies.

•

MOC deliver both a short-term (SOE) and long-term (LOE) orbit file. The SMPS
should use the SOE file. The orbit file must cover at least the time period needed
for the set of ODs to be planned.

•

The PSF files are imported by the FTS and placed in the 'psf' directory. The
SMPS automatically chooses the file with the highest version number for a given
OD. If it is required to revert to an earlier version, MOC should be asked to
redeliver the required file with a new version number.

•

The POS, ICP, PNG and SSF files always have matching same version numbers.
The version number is not necessarily the same as that of the PSF file. Do not
delete these files as the SMPS uses them to keep track of version numbers.

•

The ephemeris files for SSO targets are obtained from the JPL Horizons system,
See section 10.1 for a description on how to run the tool to retrieve those files.
Under the horizons directory a new directory /yymmdd_hhmmss is created for
each tool execution. The file names under that directory are simply the NAIFIDs
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of the targets (e.g. 501 for Jupiter's moon “Io”). Note that the SSO files sent to
MOC are reformatted and have different file names, according [RD8].
•

The DE405 file is a set of ephemerides for the major planets and the Moon,
obtained from JPL2. This file should be valid for the entire duration of the mission.

•

When the SMPS exports files to MOC, they are wrapped in an FTS wrapper file
and placed in the transfer/files directory. A message file is placed in the
transfer/msg directory to initiate the transfer. When the transfer is complete, the
FTS deletes the message file.

•

The STPF is the Slew Time Predictor File and the OBDB file is the On-Board
Database file, containing various parameters used by the ACMS. These files are
delivered by MOC via FTS.

•

The PNG files contain snapshots of the SMPS screen when the POS/ICP files are
generated.

The directories where the files are located are specified by the following properties, with
default values as shown:
hcss.pointing.orbitdir

= ${var.mps.datadir}/orbit

hcss.pointing.ephemdir

= ${var.mps.datadir}/de405

hcss.pointing.siamdir

= ${var.mps.datadir}/siam

hcss.pointing.ssodir

= ${var.mps.datadir}/horizons

hcss.mps.posdir

= ${var.mps.datadir}/posicp

hcss.mps.psfdir

= ${var.mps.datadir}/psf

hcss.mps.ssfdir

= ${var.mps.datadir}/ssf

hcss.mps.snapdir

= ${var.mps.datadir}/png

hcss.mps.fts.files

= ${var.mps.datadir}/transfer/files

hcss.mps.fts.message

= ${var.mps.datadir}/transfer/msg

hcss.pointing.stpf_dir

= ${var.mps.datadir}/stpf

hcss.pointing.obdb_dir

= ${var.mps.datadir}/obdb

The default value of ${var.mps.datadir} for the top-level directory allows many of
these properties to be omitted if the data directories are placed within this top-level
directory.
The following Java properties specify the files currently in use within these directories.
They should be updated when a new files are received.
hcss.pointing.orbitfile

= H20070328_0001.SOE

hcss.pointing.ephemfile

= ascp2007-2020.405

The original ASCII file, covering the 20 years from 2000-2020, was obtained from
ftp://ssd.jpl.nasa.gov/pub/eph/planets/ascii/de405/ascp2000.405. This file has been shortened to cover only
the period 2007-2020 and renamed ascp2007-2020.405.
2
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hcss.pointing.siamfile

= 0001_0001.SIAM

hcss.pointing.obdb_file

= OBDB_4_0_B000_20080924.csv

hcss.pointing.stpf_file

= STPF_00000_2008109.csv

3.6 Initial Conditions
Normally, the SMPS remembers the attitude of the spacecraft at the end of one OD and
uses it as the starting attitude at the beginning of the next OD. When the SMPS is used for
the first time after launch (say at OD 30), MOC will notify the HSC of the initial attitude
of the spacecraft, expressed as a quaternion. This attitude and the first OD number are
entered using a set of properties, as in the following example:
hcss.mps.initial.od = 30
hcss.mps.initial.attitude.x
hcss.mps.initial.attitude.y
hcss.mps.initial.attitude.z
hcss.mps.initial.attitude.w

=
=
=
=

-0.06840235461084
-0.73299585583512
-0.39824039007191
+0.54721365564797

In the event that a serious problem occurs during operations, such that HSC has to stop
generating schedules for one or more days, these properties can be used to set the OD
number and attitude at which planning is to resume.
Note: In operations, MOC provide the initial attitude. For maintenance purposes on a test
system, it may sometimes be useful to generate a suitable initial attitude. This may be
done using the following command on the command line, with the OD number as the
argument:
initatt 30

This command prints properties that may be copied into the property file.
3.7 Memory
The SMPS requires sufficient Java heap space to load the observation requests and other
data into memory. Since only one sub-instrument is used per day, the number of requests
loaded is less than the total number of unscheduled requests in the database.
The heap size is set by the “java.vm.memorymax” property in the user.props file:
java.vm.memory.min=512m
java.vm.memory.max=3G

In principle, the Java VM allows up to 4GB on a 32-bit machine and essentially unlimited
memory on a 64-bit machine, subject to there being sufficient memory available on the
computer (physical + virtual). However, UNIX/LINUX (32-bit) may further limit this to
around 2-3 GB depending on the kernel settings. SUSE-10.3 32-bit appears to allow
settings of up to 2642m.
If the heap space setting is too large, the following error message may occur:
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Error occurred during initialization of VM
Could not reserve enough space for object heap
Could not create the Java virtual machine.
If the physical memory is too small for the requested heap size, the program may start to
use virtual memory and become extremely slow.
For a 32-bit machine, it is recommended that there should be 4GB of physical memory
and the heap size should be as large as possible (at least 2GB).
3.8 Database Administration
This note is only relevant for database administrators.
The object database maintains counters to allocate unique numbers to every observation
and every telecommand generated throughout the mission. When a new database is
created, the telecommand ID is initialized to 0 and the observation ID is initialized to a
value depending on the 'siteid' property (see above).
If, for any reason, it is necessary to create a new database after the start of the mission, it is
important to set these counters to their previous values, otherwise they will be reset to zero
and the numbers will no longer be unique.
This is not an issue for draft schedules generated by the ICCs, since the IDs are allocated
during POS generation, which always takes place on the operational system at the HSC.
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4 User Interface
4.1 Main Window
Menu bar

Info pane

Tool bar

Tab bar

Time view

Divider

Table view

Figure 2: The SMPS main window

Sky view

Scroll/zoom
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The SMPS User Interface has four main views of the data, as shown in figure 2.
•

The time view displays the scheduled observations on a time-line, in addition to
any temporal constraints on their placement.

•

The sky view displays the candidate observations that could be scheduled on that
OD, plus any spatial constraints on their placement. In addition, it highlights the
scheduled observations and draws the slew path that links them.

•

The requests table view displays the candidate observations as a multi-column
table, giving details about each observation.

•

The schedule table view displays the scheduled observations as a time-ordered
sequence.

The table views are displayed by selecting the appropriate tab in the tab bar. There are
also tabs displaying problems and messages.
The four views are linked together, so that selecting an observation in one will cause it to
be selected it in the others. An observation only appears in the time view or schedule table
view if it is already scheduled.
Where appropriate, matching colours are used when an item is displayed in both the time
view and sky view. For example, observations are shown in yellow and slews in red.
Similarly, the DTCP/MGA constraint is shown in pink in both views and the selected
observation is highlighted in cyan.
4.2 Time View
SOPS
window

DTCP

AOS_CHK
window

R/T
window

Slew

OD

Selected
observation

Observation

Temporal
constraints

Time scale

Slew to
next DTCP

Figure 3: The time view
The time view displays the time-line for a single OD and the relevant temporal constraints.
The time view shows only the scheduled observations, whereas the sky view shows all the
observations that are available for scheduling. The time scale is in hours starting from the
beginning of the OD.
Special windows are displayed in different colours. The AOS_CHK and SOPS windows
are reserved for use by MOC. The R/T (Real-Time science) window allows observations
to send real-time telemetry (see section 4.2.4).
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4.2.1 Observations and Slews
The observations in the time view are shown as yellow rectangles, the length of which
indicates the duration of the observation (see figure 4). The slew from the previous
observation is shown in red and belongs to the observation so that this time is available for
instrument set-up prior to arriving at the target. The set-up period is shown by an
extension of the lower half of the yellow rectangle to the left.
slew

observation

setup

Figure 4: Slew longer than set-up

If the slew takes less time than the instrument set-up, the spacecraft will slew to the target,
complete the set-up and then begin the observation, as shown in figure 5:
slew

observation

setup

Figure 5: Slew shorter than set-up
Figure 6 shows various situations that arise in a schedule:

Time wasted
slewing

No time
wasted

Gap between
observations

Figure 6: Observations and slews
If the yellow lower parts of the observations join up without a break, it indicates that no
unnecessary time is wasted slewing. In practice, the set-up times of typical observations
are around 1 to 2 minutes, allowing slews of a degree or so without wasting time.
In general, once an observation is scheduled, the start time of the measurement (after the
slew) remains fixed, but the slew start time may change as other observations are added to
or deleted from the schedule.
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4.2.2 Moving Observations
Observation can be dragged around in the time view using the middle mouse button. If an
observation is dragged to an invalid time (e.g. overlapping another observation), it will
snap to the closest allowed time to that point.
Tip: If you deliberately try to overlap observations slightly, they will be packed as
tightly as possible.
When the order of the observations in the schedule is changed, by dragging one past
another, the red slew bars change length to reflect the new slew times.
The Pack Left and Pack Right buttons on the tool bar provide an easier way to pack all
observations to the left or right.
The selected observation is outlined in cyan blue in the time view and sky view. All
observations can be deselected by clicking a blank area of sky in the sky view.
4.2.3 Time Constraints
The pink region in the time view (see figure 3) is the DTCP and has a corresponding
attitude constraint shown in pink in the sky view. Only observations within this constraint
region can be scheduled during DTCP.
When an observation is selected, red and blue lines will appear in the time view showing
the placement constraints. Red indicates where the observation may be placed if no other
observations are scheduled. Blue indicates where it may be placed taking into account the
other observations.
The red constraint is often simply the periods corresponding to instruments windows (less
slew times). However, this may be further restricted by fixed-time constraints etc.
4.2.4 Real-Time Science Window
Observations may be flagged as Real-Time, meaning that they will send real-time
telemetry. This is indicated by a tick mark in the 'RT' column of the requests table. This
flag may be set or cleared using the “Toggle real-time” command on the observation popup menu. This menu may be invoked from the sky view, time view, requests table or
schedule table, using the right mouse button.
Observations which are flagged in this way may only be scheduled in the Real-Time
science window, which is shown in purple in the time view. The real-time status cannot be
set for an observation that is currently in the schedule; in this case, first delete the
observation from the schedule, set its real-time flag, then reschedule it.
When the POS file is generated, any observations with the real-time flag set are marked
with the POS keywords RT_SCIENCE_START and RT_SCIENCE_STOP.
Note: The current implementation does not save the real-time status in the SSF file. Hence
if a schedule is reloaded from an SSF file, the real-time observations will still be placed in
the real-time window but will not be marked in the POS file. Hence, no real-time
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telemetry will be sent. Until this is fixed, it is important to manually set the real-time on
any real-time observations loaded from an SSF file.

Herschel

SMPS
User Guide

Doc.
Issue
Date
Page

Herschel-HSC-DOC-1059
Issue 2.1
15.06.10
25

4.3 Sky View
The sky view displays the observations and spatial constraints on the sky as shown in
figure 7.

DTCP
attitudes

Earth &
Moon
constraints

MGA
constraint

Slew

Cursor
Scheduled
coordinates observation

Graticule

Planet
constraint

Unscheduled
observation

Figure 7: The sky view

Advised Sun
constraint

Sun
constraints

Pan/zoom
buttons
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4.3.1 Coordinates and Projections
The graticule shows meridians and parallels in equatorial coordinates, with lines of right
ascension (RA) and declination (DEC) every 10 degrees. The “RA” and “DEC” areas
below the sky view show the cursor coordinates.
The projection can be changed using the Projection command on the View menu. The
Orthographic projection is a good general purpose one for normal use. The Gnomonic
projection has the property the great circles passing through the centre are shown as
straight lines. The Mollweide projection is an equal-area projection which displays the
whole sky at once.
The Mission Planner will normally choose a small area of sky for a particular OD to avoid
excessively long slews that waste time. In this case, the sky view is zoomed in to the area
of interest and it does not make too much difference which projection is used. When the
zoom factor is high, the different projections are essentially the same for the small area of
sky displayed.
The sky view shows the sky as seen by an observer at the spacecraft looking at the sky.
When equatorial North is at the top, the right ascension increases to the left and the
declination increases upwards.
Note: When the orthographic view is zoomed out, so that the entire celestial sphere is
visible, the view is effectively that of the rear hemisphere, with the front hemisphere
removed. If the view were of the outside of the celestial sphere, it would be reversed
compared with that seen by an observer at the spacecraft.
Note: The sky view displays pointings and slews as the path of the spacecraft X-axis
(ACA coordinates) rather than instrument boresight coordinates. These may differ slightly
as a result of the SIAM offset.
4.3.2 Scrolling and Zooming
The sky view can be zoomed, rotated and scrolled using the nine buttons along its bottom
edge. If the cursor is held over one of the buttons, a tool-tip message appears after a few
seconds to explain the purpose of the button.
To zoom in to a particular area more easily, select a rectangular region by dragging the
mouse in the sky view with the middle button depressed. (The resulting view may differ
slightly from the selected area because the selected rectangle may not be a rectangle after
zooming, given the projection in use.)
The “centre” button scrolls the sky view so that currently selected observation is at the
centre of the view. If no observation is selected, the button returns the view to its default
centred on a right ascension and declination of zero, with equatorial North at the top.
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4.3.3 Spatial Constraints
The sky view shows a number of constraints:
•

Bright green - Sun, Earth, Moon, Mars, Jupiter and Saturn constraints

•

Dark green - Advised Sun constraint

•

Pale blue - Star tracker Moon constraint

•

Pink - MGA (antenna) constraint on pointing during DTCP

The Sun constraints are currently at beta angles of approximately ± 30°. However, if
possible it is recommended to keep the beta angle in the range -30° to +20° to avoid
heating of the service module by the Sun. The dark green advised Sun constraint shows
the +20° limit.
There are two MGA antenna constraints, which appear as approximately elliptical regions,
diametrically opposite one another. These are the two regions that simultaneously satisfy
the MGA-earth constraint on the Z-axis and the Sun constraint on the X-axis, whilst
keeping the alpha (roll) angle at zero. Normally the DTCP region nearest the Sun is used
to minimize heating of the service module.
When the Sun-Earth angle subtended at the spacecraft is less than the maximum antenna
angle the two MGA regions merge into one. This happens for short periods twice a year
for the New Norcia ground-station. During these times, a larger area of sky is usable for
scientific observations during DTCP.
The constraints are drawn for the time of the currently selected observation. If no
observation is selected, the constraints are shown for the middle of the OD. Hence,
clicking on an observation will display the constraints for that observation. Similarly,
dragging the observation in the time view will cause the constraint to be redrawn.
4.3.4 Selecting Observations
Selecting an observation in any of the views will cause it to be selected in the other views.
Tip: If two observations are very close together in the sky view, it may help to
zoom in so that you can select the one you want. If the observations are in exactly
the same location, it may be difficult to select the correct one in the sky view, in
which case it may be easier in one of the table views.
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4.3.5 Viewing Pointings
Right-clicking on an observation in one of the views brings up a pop-up menu which
shows operations that may be performed on the observation. The 'Display pointing'
command on this menu displays the pointing pattern in detail.

Figure 8: Display of raster pointing
Fine pointings and scan lines are shown in yellow and slews in red. The window has the
same zoom and scroll controls as the sky view and a File menu with the option to print the
view.
The “display pointing” command provides a schematic view of the pointing, which does
not necessarily include all the complexities of the real observation, such as interrupted
slews in line scans. The observation does not need to be scheduled, so the orientation is an
approximate one for the OD. Once an observation is scheduled at a particular time, it is
possible to generate a more accurate view using the ACMS simulator (see section 6).
For further details of the pointing patterns see [RD9].
4.3.6 Observations and Slews
Unscheduled observations are shown as small white dots. If the pointing pattern (e.g.
raster) covers a larger area of sky, the observation may start and end at different attitudes.
In this case, the observation is drawn as a white line connecting the two points (This will
be replaced by a rectangle showing the raster, in a later release).
Scheduled observations are shown as yellow dots, connected by red slew lines. The initial
and final attitudes for the OD are shown as yellow dots within the pink DTCP/MGA
constraint in the sky view. These are normally about a degree apart as the Sun constraint
moves at about 1 degree per day. When a new OD is opened for planning, no observations
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are yet scheduled and the sky view shows a red slew path connecting the initial and final
DTCP attitudes.
As observations are added to the schedule, the slew path is drawn connecting these
together in the sky view.
4.4 Tab Bar
The lower part of the window has a tab bar that allows the following to be selected:
•

Requests table view (see section 4.5)

•

Schedule table view (see section 4.6)

•

Problems pane (see section 4.7)

•

Message pane (see section 4.8)

The divider bar under the sky view allows the sky view and tab area to be resized relative
to one another. The small arrows on the left-hand end of this bar allows either view to be
expanded to its maximum size and then returned to the original setting.
4.5 Requests Table View
The requests table view shows a list of the candidate observations that are available for
scheduling. This view is selected by clicking on the “Requests” tab in the tab bar.

Figure 9: The requests table view
Clicking on a column header causes the table to be sorted in ascending order on that key.
Clicking a second time sorts the table in descending order and clicking a third time cancels
the sorting. A triangular arrow head in the header indicates the sort key and sorting
direction. The table can be sub-sorted on further fields by control-clicking on additional
column headings. Sub-sorting preserves the previous sort order when the items have equal
values. A smaller arrow head appears in the header of these columns. Sorting the table is
useful to find a particular observation by ID or to look at all observations of a particular
type.
A small yellow marker at the left-hand side of an entry indicates that the observation is
currently in the schedule. Clicking on the header of this column will group together all the
scheduled observations, although not necessarily in the order they appear in the schedule.
A time-ordered view of the schedule is given by the schedule table view which can be
displayed by pressing the Schedule tab on the tab bar.
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The column headers can be dragged left and right to rearrange the order. It is also possible
to resize the column widths by dragging the edges of the column headers.
Most of the column titles are self explanatory. The 'inst' column shows the sub-instrument,
with the band as a suffix in the case of HIFI. The 'const' column may contain the letters T,
G and F to indicate that various types of constraint are present, as follows:
T

Fixed-time constraint (including chopper avoidance and map orientation)

G

Group, sequence or concatenation constraint

F

Follow-on constraint

T constraints are applied automatically. The G and F constraints are not yet implemented
and it is necessary to check for concatenations manually.
The 'MC' column shows the Mission Configuration of the observation. Note the the SMPS
is able to schedule observations from more than one mission configuration in a single OD.
The 'RT' column displays a tick mark if the observation is flagged to send real-time
telemetery. This flag may be toggled by right-clicking the observation and selecting the
“Toggle real-time” command.
Concatenated observations are shown as multi-line entries in the table. Such observations
are treated as a single entity for scheduling purposes. The duration column in the table
shows the total duration of the sequence of observations.
4.6 Schedule Table View
The schedule table view shows the sequence of observations included in the schedule and
any additional slews such as the one to the final DTCP attitude.
The entry for each observation shows the slew duration preceding the start of the
observation, the start time, the duration (excluding the slew) and the end time. The start
and stop times change when an observation is moved in the time view.
The table cannot be sorted as the order of the schedule is fixed.

Figure 10: The schedule table view
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4.7 Problems Pane
The problems pane displays any validation problem detected in the schedule when the
POS is generated or when the user performs a validation or a simulation of the schedule,
as shown in figure 11.

Figure 11: The problems table view
Two types of problems are shown: ERROR and WARNING. The pane also displays
INFO messages; these are for information purposes only and may be safely ignored. The
tab is highlighted in red when problems are found and it is brought to the foreground. The
user is able to generate a POS file if there are warnings but not when there are errors.
The problem table can be sorted in a similar way to the requests table by clicking on a
column heading. Clicking on a problem entry will select the affected observation so it can
be located in the other views.
Schedule validation and errors are described in section 6.
4.8 Message Pane
•

The bottom pane has a tab "Messages" to display any log messages.

4.9 Info Pane
At the very bottom of the SMPS main window is a bar that shows information about the
schedule:
•

The OD number being planned

•

The unused time remaining, excluding any in DTCP

•

The total slew time

4.10 Undoing Changes
The Undo button on the tool bar allows changes to the schedule to be undone. The Redo
button allows undone changes to be reapplied.
This undo/redo mechanism applies to changes to the schedule but not to the view (e.g
zooming or projection). Once the POS/ICP files have been generated, changes cannot be
undone.
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Another way to undo changes is to save a snapshot of a schedule as an XML file and
subsequently reload it.
4.11 Menu Bar
The Menu bar at the top of the main window contains the following menus.
4.11.1 File Menu
The File menu contains the following commands:
New Schedule...

Starts planning of the next OD in sequence

Close

Close the schedule being edited

Open schedule...

Load a schedule saved as an SSF (XML) file

Save schedule...

Save a schedule as an SSF (XML) file

Batch schedules...

Regenerate sequence of schedules from SSF files

Generate POS

Generate the POS/ICP files and commit to database

Submit to MOC...

Send all completed POS/ICP files to MOC

Check submissions... Check whether schedules have been transferred to MOC
Decommit...

Decommit schedules for one or more ODS

Print...

Print the SkyPane to a printer or file

Quit

Quit the SMPS program

4.11.2 Schedule Menu
The Schedule menu contains the following commands:
Undo

Undo changes to the schedule

Redo

Redo changes that have been undone

Add

Add the selected observation to the schedule

Delete

Delete the selected observation from the schedule

Add slew...

Add an extra slew

Pack left

Pack all observations in schedule to the earliest time

Pack right

Pack all observations in schedule to the latest time

Exclude DTCP

Don't allow scheduling in the DTCP window

Optimize

Optimize the order of observations in the schedule

Check/Fix

Check for some subtle timing issues (temporary command)

Validate

Validate the schedule

Simulate

Validate the schedule and display a simulation

Print schedule

Print a summary of the schedule to the messages pane
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Display the total size of TM data that will be generated

4.11.3 View Menu
The View menu contains the following commands:
Refresh

Redraw the graphics (not normally needed)

Projection

Select the projection used in the Sky View:
•
•
•

Orthographic
Gnomonic
Mollweide

4.11.4 Help Menu
The Help menu contains the following commands:
About...

Display information about SMPS including the build number

4.12 Observation Menu
Right-clicking on an observation in one of the views brings up a pop-up menu with special
operations that may be performed on the observation. This menu contains the following
commands:
Display pointing

Displays the pointing pattern in a new window

Toggle real-time

Sets/clears to real-time flag (shown in requests table 'RT' column)

4.13 Tool Bar
The Tool Bar appears under the Menu Bar when a schedule is open. It duplicates a number
of commonly used menu functions as buttons for quick access. The button icons are
displayed beside the menu items so that this correspondence is clear.
If the cursor is held over a Tool Bar button, a tool-tip message will appear after a few
seconds to explain the purpose of the button.
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5 SMPS Tutorial
5.1 Introduction
This section describes the tasks performed by the Mission Planner in tutorial form. The
relevant features of the SMPS user interface are introduced as they are needed. It is
suggested that new users should work through this tutorial introduction using the SMPS to
gain familiarity with the planning process and the software.
Note: Training should not be carried out on the operational system as it will generate data
in the database.
5.2 Seven-Day Plan
When a new set of PSFs are received (normally seven at a time), the sub-instrument to be
used on each of the days should first be decided (see section 2.3). Then, planning of the
individual days can proceed as described below.
5.3 Starting the SMPS
•

Ensure that the necessary PSF files and orbit file have been imported using the
FTS.

•

Ensure that the following property references the orbit file:
hcss.mps.orbitfile = H20070328_0001.SOE

•

Type "smps" to start the SMPS Software.

5.4 Creating Schedules
•

Select "File/NewSchedule..."
A dialog displays the number of the next Operational Day (OD) to be planned.
Select the sub-instrument(s) for that day and press "OK". The SMPS will read the
observations from the database and display any that could be scheduled on this
OD. This may take a few minutes if there are a large number of observations in the
database.
Normally, an OD is dedicated to a single sub-instrument (see section 2.3).
However, in special circumstances it is possible to select more than one subinstrument.

•

The SMPS main window is displayed (see section 4.1). There are four main views
of the data:
•

the time view (see section 4.2)

•

the sky view (see section 4.3)

•

the requests table view (see section 4.5)
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the schedule table view (see section 4.6)

You can select an observation in any of the views and it will be selected in the
other views where applicable.
•

The time view shows the time-line of scheduled observations and the relevant
temporal constraints. The time scale is in hours starting from the beginning of the
OD. The pink region is the DTCP and has a corresponding attitude constraint
shown in pink in the sky view. Only observations within this constraint region can
be scheduled during DTCP.

•

The sky view shows the observations that are available for scheduling.
Tip: If two observations are very close together in the sky view, it may help to
zoom in so that you can select the one you want. If the observations are in exactly
the same location, it may be difficult to select the correct one in the sky view, in
which case it may be easier in one of the table views.

•

You can right-click on an observation in one of the views to get a pop-up menu.
This has three options:
•

Display the pointing pattern in detail (see section 4.3.5). In this view, fine
pointings and scan lines are shown in yellow and slews in red. The window
has a File menu with the option to print the view.

•

Set the real-time flag. This force the observation to be scheduled in the realtime window and enables real-time down-linking of telemetry.

•

Toggle locking of an observation. A locked observation cannot be moved
or deleted. Consequently, it is not affected by the pack-left, pack-right or
optimise commands.

•

The requests table view shows details of the observation requests. You can click
the column headers of this view to sort in ascending or descending order. This is
useful to find a particular observation by ID or to look at all observations of a
particular type. You can control-click on further column headings to sub-sort. You
can drag the column headers left and right to rearrange the order if you want.

•

The divider bar under the sky view allows the sky view and table views to be
resized relative to one another. The small arrows on the left-hand end of this bar
allow you to expand either view to its maximum size and then return to the original
setting.

•

The bottom pane has a tab "Messages" where you can see any log messages.

•

The sky view shows a number of constraints:
Bright green - Sun, Earth, Moon, Mars, Jupiter and Saturn constraints
Dark green - Recommended Sun constraint
Pale blue - Star tracker Moon constraint
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Pink - MGA (antenna) constraint on pointing during DTCP
•

The sky view can be zoomed, rotated and scrolled using the eight buttons along its
bottom edge. You can change the projection using the Projection command on the
View menu. To zoom in to a particular area more easily, just drag with middle
mouse button in the sky view.

•

The “centre” button allows an observation to be located quickly. Pressing the
button centres the sky view on the currently selected observation. If no observation
is selected, the view is returned to the equatorial origin (right ascension and
declination of zero) with North at the top.

•

The schedule table view shows the scheduled observations in the form of a table
with their start and end times.

•

To schedule an observation, select it in the sky view or requests table view and
then press the "+" button on the tool-bar. The observation will then appear in the
time view, initially positioned at the earliest time at which it can be scheduled. To
remove an observation, press the "-" button.

•

You can drag the observation around in the time view using the middle mouse
button. If you try to place the observation at an invalid time (e.g. overlapping
another observation), it will snap to the closest allowed time to that point.
Tip: If you deliberately try to overlap observations slightly, they will be packed as
tightly as possible.

•

The constraints in the sky view are drawn for the time of the currently selected
observation. Hence they will change if an observation is dragged to a different
time. If no observation is selected, the constraints are drawn for the middle of the
OD.

•

The Pack Left and Pack Right buttons (with blue dots) pack all the observations in
the schedule as far left or right as possible, whilst preserving the order. This is
much easier than trying to pack them manually. Locked observations are not
moved.

•

If you want to prevent scheduling during DTCP, select "exclude DTCP" from the
Schedule menu. Then when you Pack Left, the first observation will start
immediately after DTCP.

•

The initial and final attitudes for the OD are shown as yellow dots within the pink
DTCP/MGA constraint in the sky view. These are joined by a red slew line. As
observations are added to the schedule, the slew path is drawn connecting these
together in the sky view.
Some observations such as rasters may start and end at different attitudes. In this
case, the observation is drawn as a white line connecting the two points (This will
be replaced by a rectangle showing the raster area, in a later release).
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•

The selected observation is outlined in cyan blue in the time view and sky view.
You can deselect all observations by clicking a blank area of sky in the sky view.

•

The observations in the time view are shown as yellow rectangles the length of
which indicates the duration of the observation (see section 4.2.1). The slew from
the previous observation is shown in red and forms part of the observation.

•

Observations may specify a minimum slew time so that the instrument can be
prepared during the slew. This is shown by an extension of the lower half of the
yellow rectangle to the left. The actual slew, which is shown in red may start
before this if the actual slew time is greater than the minimum slew time. If all the
slews are smaller than the minimum, the yellow lower parts of the observations
will join up without a break (after packing), indicating that no unnecessary time is
wasted slewing.

•

When an observation is selected, red and blue lines will appear in the time view
showing the placement constraints (see section 4.2.3). Red indicates where the
observation may be placed if no other observations are scheduled. Blue indicates
where it may be placed taking into account the other observations.

•

The red constraint is often simply the periods corresponding to instruments
windows (less slew times). However, this may be further restricted by fixed-time
constraints etc.

•

If you make a change to a schedule and don't like the result, it is easy to undo it.
The Undo/Redo buttons allow changes to the schedule to be undone right back to
the start of the session.

•

If you want to save a snapshot of a schedule, select "Save schedule" from the File
menu. This will create an XML file in Scheduling Summary File (SSF) file format.
To reload it, use "New schedule" to create an empty schedule for the correct OD,
then use "Open Schedule" to load the SSF file.
Tip: This is useful if you want to close down SMPS, while you are in the middle of
creating a schedule, and then carry on the next day. It is also useful to create a
snapshot so that you can easily return to a given point.
By default, these files are saved in your home directory, whereas the SSF created
during POS/ICP generation is placed in the “ssf” directory (see below).

•

The Open Schedule command loads an SSF file, adding the observations to any
that are already in the schedule. If there are clashes it may adjust the scheduled
times and give a warning.

•

The Print command on the File menu allows the sky view to be printed to a printer
or file.

•

When a suitable schedule has been created, perform a quick visual check that the
time-line in the time view and slew-path in the sky view look sensible.
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•

The command “Show TM” on the Schedule menu displays the total amount of
telemetry data that will be generated in MB. It is also shown as a percentage of a
limit set by the property hcss.mps.maxtm (see section 9). If this exceeds 100%,
you will be asked for confirmation to proceed when generating the POS file.

•

The schedule can be validated by selecting “Validate” from the schedule menu.
Any problems are shown in the problem pane; Note that this pane is not updated
automatically. The “Simulate” option performs the validation and then displays
the detailed pointing (see section 6 for details).

•

Occasionally, a warning dialog may report that an observation cannot be scheduled
at a certain time. This is due to subtle cases where there are interactions between
consecutive observations. In this case, use the “Check/Fix” command on the
“Schedule” menu. This will make small adjustments to the start times of
observations as necessary to fix the problem. Then, try validating the schedule
again.

•

If a constraint is violated by a slew, it may be possible to avoid it by changing the
order of the observations. Alternatively, it is possible to insert an extra slew
manually, to create a “dog-leg” around the constraint. Decide where to place a
“way-point” and read the coordinates from the RA and DEC fields. Then select
“Add slew...” from the Schedule menu and enter the coordinates. The resulting
slew is shown in red in the Time View. It may be dragged like an observation.

•

The POS, ICP, PNG and SSF files are generated using "Generate POS" on the file
menu. After performing a validation, this creates a pair of files in the "posicp"
directory, such as 0084_0003.POS and 0084_0003.ICP, a Scheduling Summary
File (SSF) in the “ssf” directory and a snapshot file (PNG) in the “png” directory.
In this example, 84 is the OD number and 3 is the version number. Do not delete
these files.

•

The Scheduling Summary File (SSF) is an XML file that contains a summary of all
the observations in the schedule. This can be read back in using the “Open
schedule” command on the File menu. If you want to edit these files, do not
modify the original files in the “ssf” directory, but first copy them to your home
directory with a different name.
Tip: If you delete the time fields from this file and then reload it, the observations
will be scheduled at the earliest possible time, whilst retaining the specified order.
The simplest possible file need only list the IDs of the observations to be
scheduled, as in the following example:
<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE schedule SYSTEM "schedule.dtd">
<schedule od="50">
<observation id="123"/>
<observation id="456"/>
</schedule>

If the <proposal> and <title> fields are present, these will be used to identify
the observation, otherwise the observation “id” attribute will be used. This allows
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SSF files to be imported from another system where the observations have
different “id” numbers. However, for local use, the “id” numbers are sufficient as
shown by the example above.
•

Generate a schedule summary for approval by the Project Scientist.

•

Normally schedules are generated in batches of seven to cover a week. The above
steps should be repeated for each of the schedules.

5.5 Schedule Optimisation
Optimisation of schedules is partially implemented, to the extent that it is useful, although
it cannot yet handle all situations.
To try it, create a schedule by hand. Then press the "magic wand" button on the tool-bar.
This will reorder the observations in the schedule to minimize the slew time. This will
often recover enough time that it is possible to schedule an extra observation. It may then
be useful to optimize the schedule again.
The “Toggle locking” command can be used to prevent engineering observations such as
cooler recycling and instrument set-up and set-down at the start and end of the schedule
from being moved.
5.6 Saving and Restoring Schedules
The Save/Open mechanism is also used by ICCs when they want to perform a trial
scheduling run themselves and then deliver their schedule to the HSC. It is possible for the
HSC to load multiple contributions into a single schedule (allowing for any clashes).
5.7 Submitting Schedules to MOC
When the schedules have been approved by the Project Scientist, the next step is to deliver
them to MOC.
Select “Submit to MOC”.
This will display a list of the schedules ready for export. Pressing the “OK” button causes
the POS and ICP files to be wrapped into an FTS wrapper file and placed in the
transfer/files directory. A message is placed in the transfer/msg directory to inform the
FTS server that a file is waiting for transfer. The message file is automatically deleted
when the transfer has taken place.
The command “Check submissions...” on the File menu can be used to verify that the POS
and ICP files up to a specified OD have been sent to MOC. This works by checking
whether the files exist in the folder specified by the property 'hcss.mps.fts.sentdir'. This
confirms that the MPS → PushPullDaemon → SendDaemon chain is working properly.
5.8 Replanning
Sometimes it is necessary to modify a schedule after the POS file has been generated or
after it has been delivered to MOC. For example, this may happen if:
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the schedule is rejected by MOC
a problem is detected by the HOT that requires replanning
a Target of Opportunity (TOO) has to be scheduled

In such cases, approval is required from the PST. It is also necessary to inform MOC who
should confirm that the schedule has not already been uplinked.
Once approval is obtained, the schedule should be decommitted and then replanned. When
a schedule is is replanned, it may affect the subsequent schedules. For example:
•

The prime instrument may change, invalidating the cooler state for the next day.

•

The final attititude may change leading to increased slew time at the start of the
next schedule.

•

Deleting an observation may invalidate observations in subsequent schedules that
form part of a sequence of observations. Similarly, deleting a calibration
observation may affect subsequent schedules.

Consequently, a schedule may only be decommitted if all the subsequent schedules are
also decommitted.
The procedure is as follows:
•

Select Decommit from the File menu. This displays a list of the schedules that
have been committed.

•

Select the first schedule to be decommitted and press OK. The SMPS will
decommit this schedule and all subsequent ones. The observations from these
schedules are reset to an unscheduled state, so that they are available for
scheduling again.

•

Repeat the planning process. The SMPS will allow the schedules to be replanned
starting with the first one that was decommitted.

•

Subsequent schedules can be regenerated automatically from the SSF files using
the “Batch schedules...” option on the File menu.
If one of the schedules cannot be recreated, the regeneration will stop with a
warning. You may then open the failing schedule, edit or accept the changes and
commit it. The batch regeneration can then be run again to regenerate the
remaining schedules.
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6 Validation and Simulation
6.1 Validation
The SMPS contains a detailed simulator for the Herschel Attitude Control and Monitoring
System (ACMS). This simulates of the execution of the ACMS commands, calculating the
spacecraft attitude each 0.25 seconds (the ACMS cycle time). The simulation accurately
models details such as the accelerations and decelerations within a line scan, tracking and
different types of slew (eigenaxis and sun-safe).
Each calculated attitude is checked against the Sun (alpha and beta), Earth, Moon, Mars,
Jupiter, Saturn, star tracker and antenna (MGA) constraints. The timing of the commands
is also modelled to detect, for example, when an ACMS command is prematurely
interrupted by another command.
If a constraint violation is detected, it is displayed in the “Problems” table. Each entry has
an associated severity which may be one of the following:
ERROR

Serious problem such as violation of beta constraint (+30˚). POS
generation cannot proceed.

WARNING

Minor problem such as exceeding the preferred beta angle (+20˚). The
mission planner must confirm acceptance before a POS can be generated.

INFO

Information message on a minor anomaly that requires no action. For
example, line-scan return slews are deliberately interrupted to save time.

A validation may be performed using the “Validate” or “Simulate” commands on the
“Schedule” menu:
•

“Validate” runs the simulation and validates the schedule.

•

“Simulate” runs the simulation, validates the schedule and displays the resulting
attitudes in a new window. This is useful for examining any errors in more detail.

Validation is also run automatically as part of the POS generation process to ensure that
POS files cannot be generated when there are errors.
Note that the problems table is not updated automatically when the schedule is changed,
because the simulation is quite time consuming.
Occasionally, a warning dialog may report that an observation cannot be scheduled at a
certain time. This is due to subtle cases where there are interactions between consecutive
observations. In this case, use the “Check/Fix” command on the “Schedule” menu. This
will make small adjustments to the start times of observations as necessary to fix the
problem. Then, try validating the schedule again.
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6.2 Simulation
When the “Simulate” command is used, a new window appears that displays the attitude
evolution for the OD in a sky view. It is possible to zoom in to inspect the details of an
individual observation. This is more accurate than the view produced by the “Display
pointing” command as it models subtle details of the ACMS behaviour.
Figure 12 shows the simulation window zoomed-in to display the details of a line-scan
observation. It can be seen that the scan slews back to the end of the scan line after
deceleration because holds are inserted between the scan lines. This is a level of detail that
is not shown by “Display pointing”.

Figure 12: Detailed simulation of a line-scan
The simulation view is not linked to the other views. For example, selecting an
observation in the requests table will not highlight it in the simulation view. This is
because the simulation is performed at the level of individual ACMS commands, rather
than observations.
Like the main sky view, the simulation view also uses spacecraft (ACA) coordinates rather
than instrument aperture (boresight) coordinates. This is because it is simulating the
spacecraft attitude. This also avoid discontinuities when the boresight changes.
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The simulation view uses the following colours:
Colour

Function

red

slew

yellow

point or scan

cyan

scan acceleration or deceleration

green

tracking of pointing

6.3 Planetary Constraints (SMPS v4 and later)
There are special constraints associated with the planets Mars, Jupiter and Saturn to avoid
unwanted stray light. These constraints are displayed as green circles in the sky view, as
shown in figure 7. The radius of the constraint depends on which instruments are selected
when starting to plan the OD. The value used is the worst case for the selected
instruments.
Technical note: Strictly, the planetary constraints apply to the instrument aperture
(boresight) in use, whereas the Sun, Earth and Moon constraints apply to the spacecraft
(ACA) X axis. This is handled by using ACA coordinates for the planetary constraints, but
increasing the radius of the constraint circle by the worst-case SIAM offset for the selected
instruments. This allows a single constraint circle to be displayed for all observations,
even if they use different apertures. It also avoids complications with slews and pointings
that do not have an associated instrument aperture. The increase in constraint radius might
occasionally prevent an observation close to a planet, but this is not a major problem
because the constraint can be disabled in such cases.
The following rules are applied:
•

It is permitted to point within the constraint circle, provided that the target of the
observation is the planet itself or one of its moons.

•

If the target is not the planet or one of its moons, an observation may not be
performed within the constraint circle and it is not allowed to slew through the
constraint circle.

Strict application of these rules would make it impossible to perform an observation of
another target following observation of a planet, because the slew to the second
observation would start inside the constraint circle! This is avoided by giving a warning
for such slews, rather than an error. The mission planner then needs to confirm that the
second observation will not be affected by following immediately after observation of the
bright target.
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These rules is summarised in the following table. In this context, “planet” means the
planet itself or one of its moons.
Condition
Target is the planet
Target is not the planet
Slew through circle when start and end are not the planet
Slew from planet to target that is not the planet

Severity
OK
ERROR
ERROR
WARNING

If it is required to perform an observation of another target (other than one of the moons)
close to a planet or one of its moons, the following properties can be used:
hcss.mps.constraint.mars_enable = false
hcss.mps.constraint.jupiter_enable = false
hcss.mps.constraint.saturn_enable = false

The default values for these properties are 'true'. Setting them to 'false' simply
downgrades the ERROR cases in the above table to WARNINGs. The constraint checks
are still performed.
There are also properties defining the planetary constraint radius for each of the
instruments. These should not be modified.
6.4 Planetary Constraints (SMPS v3)
In SMPS version 3, the planetary constraint checking was less exact. There were three
properties specify the constraint radius (in degrees) for the three planets:
hcss.mps.constraint.mars_min = 1.5
hcss.mps.constraint.jupiter_min = 1.5
hcss.mps.constraint.saturn_min = 1.5

All observations within this radius, including the planet and its moons, were disallowed.
The only way to observe a planet was to set the relevant property to '0' to disable the
constraint check. There were then no constraint checks for this planet for the whole OD.
This could result in unintentional scheduling of another target close to a planet.
These properties are no longer used in SMPS v4. Observation of planets or their moons no
longer requires disabling the constraints.
6.5 Hot MGA Region
There are two MGA constraint regions, corresponding to the hot and cold service module
cases. By default, the SMPS always uses the cold region, as this leads to better pointing
accuracy.
In special cases, this behaviour can be overidden by setting the following property:
hcss.mps.hot_mga = true
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When this option is used, a warning will appear in the problems pane if the DTCP attitude
is in the part of MGA region beyond the preferred maximum beta angle (+20º).
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7 Known Problems and Limitations
7.1 Known Problems and Solutions
A number of features are not yet complete and work-around solutions are necessary in
order to use the software.
•

The scheduling preferences dialog is not yet implemented. However, some help is
given by selecting a single sub-instrument for an OD and using the requests table
view to find/group relevant observations.

•

The real-time status of an observation is not saved in the SSF file. This must be
reset manually after reloading the file.

7.2 Limitations
Not applicable.
7.3 Miscellaneous
To be written:
•

Exporting SIAM and SSO files to MOC
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8 Problem Reporting
If problems are encountered, please submit a Software Problem Report (SPR). This should
specify the HCSS build number (which can be found by selecting “About...” from the
Help menu).
If relevant, please attach (or send separately):
•

any stack-trace from the terminal window in which the SMPS was started

•

the log which can be cut-and-pasted from the “Messages” pane.
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9 Special Properties
In addition to the standard properties described in section 3, the SMPS uses a number of
additional properties. These should not normally be changed by users. They are
documented here for completeness.
9.1 Directory Properties
By default, the SMPS assumes the directory structure given in section 3.5. This is
achieved using the following properties that are set by default:
hcss.pointing.orbitdir

= ${var.mps.datadir}/orbit

hcss.pointing.ephemdir

= ${var.mps.datadir}/de405

hcss.pointing.siamdir

= ${var.mps.datadir}/siam

hcss.pointing.ssodir

= ${var.mps.datadir}/horizons

hcss.mps.posdir

= ${var.mps.datadir}/posicp

hcss.mps.psfdir

= ${var.mps.datadir}/psf

hcss.mps.ssfdir

= ${var.mps.datadir}/ssf

hcss.mps.snapdir

= ${var.mps.datadir}/png

hcss.mps.fts.files

= ${var.mps.datadir}/transfer/files

hcss.mps.fts.message

= ${var.mps.datadir}/transfer/msg

9.2 ACMS Properties
The following properties specify the location of the Slew-Time Predictor File (STPF) and
On-Board Database file (OBDB):
hcss.pointing.stpf_dir

= ${var.mps.datadir}/stpf

hcss.pointing.obdb_dir

= ${var.mps.datadir}/obdb

hcss.pointing.obdb_file

= OBDB_4_0_B000_20080924.csv

hcss.pointing.stpf_file

= STPF_00000_2008109.csv

In addition, the following property specifies the number of reaction wheels in use:
hcss.pointing.acms.wheels = 4

9.3 Constraint Properties
The Sun alpha (roll) angle and Solar Aspect Angle (SAA) constraints are specified by the
following properties (in degrees):
hcss.mps.constraint.alpha_min

= -2.9

hcss.mps.constraint.alpha_max

= 2.9

hcss.mps.constraint.saa_min

= 60.6

hcss.mps.constraint.saa_max_rec

= 110

hcss.mps.constraint.saa_max

= 119.4
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The constraint angles (in degrees) on other bright bodies are given by:
hcss.mps.constraint.earth_min

= 23

hcss.mps.constraint.moon_min

= 13

hcss.mps.constraint.str_moon_min = 20

Planet constraint properties (SMPS v3 only):
hcss.mps.constraint.jupiter_min

= 1.5

hcss.mps.constraint.saturn_min

= 1.5

hcss.mps.constraint.mars_min

= 1.5

Planet constraint properties (SMPS v4 and later):
hcss.mps.constraint.hifi_planet_min

= 0.6

hcss.mps.constraint.pacs_planet_min

= 1.5

hcss.mps.constraint.spire_planet_min = 1.5
hcss.mps.constraint.mars_enable

= true

hcss.mps.constraint.jupiter_enable

= true

hcss.mps.constraint.saturn_enable

= true

The MGA constraint angles (in degrees) for the ground-stations are given by:
hcss.mps.constraint.mga_kru_max = 10
hcss.mps.constraint.mga_nno_max = 15
hcss.mps.constraint.mga_ceb_max = 10
hcss.mps.constraint.mga_per_max = 10
hcss.mps.constraint.mga_mas_max = 10

The following property allow HOT MGA region to be used:
hcss.mps.hot_mga = false

9.4 Miscellaneous Properties
The following property specifies the maximum amount of telemetry per OD in kilobytes:
hcss.mps.maxtm = 1404000

The default value corresponds to 130 kb/s for a 24 hour OD.
9.5 GUI Layout Properties
The following properties specify the initial size of the SMPS main window in pixels, and
the position of the divider (in the range 0 to 1):
hcss.mps.gui.width

= 900

hcss.mps.gui.height

= 950
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hcss.mps.gui.divider = 0.8

9.6 Colour Properties
The following properties specify the colour of various Graphical User Interface (GUI)
components:
hcss.mps.gui.color.observation

= 0xFFFFFF

hcss.mps.gui.color.scheduled

= 0xFFFF00

hcss.mps.gui.color.slew

= 0xFF0000

hcss.mps.gui.color.selected

= 0x00FFFF

hcss.mps.gui.color.constraint

= 0x00FF00

hcss.mps.gui.color.constraint2

= 0x326420

hcss.mps.gui.color.star_tracker

= 0x89C0C0

hcss.mps.gui.color.graticule

= 0x8A8A00

hcss.mps.gui.color.sky

= 0x000000

hcss.mps.gui.color.timebackground = 0x404040
hcss.mps.gui.color.log

= 0xE6E6C8

hcss.mps.gui.color.dtcp

= 0xD76666

hcss.mps.gui.color.aos_chk

= 0xEAB560

hcss.mps.gui.color.psf

= 0xA0A0A0

hcss.mps.gui.color.rt_science

= 0xBE9BD0

hcss.mps.gui.color.engineering

= 0x40A0A0

hcss.mps.gui.color.sops

= 0xC88B8C9

hcss.mps.gui.color.instrument

= 0x808080

hcss.mps.gui.color.scale

= 0xFFFFFF

hcss.mps.gui.color.placement1

= 0xFF0000

hcss.mps.gui.color.placement2

= 0x5096FF

hcss.mps.gui.color.scheduled_locked = 0xFF9900

Each value is in hexadecimal number of the form 0xRRGGBB, specifying Red, Green and
Blue components in the range 00 to FF.
9.7 FTS Properties
The source and destination for FTS transfers are set by the following properties:
hcss.mps.fts.source = HSC
hcss.mps.fts.dest

= SDA

9.8 Mission Configuration
The mission configuration is set by the following property:
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hcss.ccm.mission.config = name

The name is a label that refers to a set of command definitions (CUS definition, calibration
tables and MIB) in the database. A new mission configuration is created each time these
definitions are updated.
This property is not used by the SMPS but is needed by the 'proptool' program used for
creating dummy observations for test purposes.
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10 Tools
10.1 Horizons ephemeris retrieval and FTS conversion
As stated in 3.5 the MPS needs a set of ephemeris files to be installed in the MPS data
directories. At the time of writing, 421 SSOs need to be considered. Those ephemeris are
retrieved from Horizons system3 Mail interface. For the automation of this process a tool
have been written to automatize this task:
10.1.1 Properties needed
The following properties have to be defined:
Property name

Default value

Description

hcss.mps.ssodir

${var.mps.datadir}/horizons

Horizons file directory

.horizons.imap.host4

scimail.esac.esa.int

IMAP host used for
receive Horizons mail

.horizons.start_time 2008-07-31T00:00:00

Start time for Horizons
ephemerids generation

.horizons.end_time

2013-04-21T00:00:00

End time for Horizons
ephemerids generation

.horizons.step_size

12 hour

Step size

.imap.username

hers_ephem

IMAP user name
IMAP user password

.imap.password
.mail.sender

hers_ephem@sciops.esa.int

Horizons sender's e-mail

.imap.folder

inbox

Horizons incoming folder

.mail.horizons

horizons@ssd.jpl.nasa.gov

Horizons service e-mail

The first property identifies where the incoming data (one file for each SPKid5), the rest of
them determines the configuration parameters of the email account created for sending and
receiving Horizons' mails.
10.1.2 Running the getephem tool
This tool simply sends one mail for each object requested to the HORIZONS system, it
waits till the incoming mails are received and store its content in the corresponding
directory. There are the ways of run the tool:

http://ssd.jpl.nasa.gov/?horizons

3

Add herschel.mps.tools.horizons prefix

4

SPKid stands for Spacecraft and Planet Kernel id, and is strictly speaking the unique designation for a SSO.

5
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For one object
In this example we are interested in retrieve ephemeris for SPK-ID 1000032
(21P/Giacobini-Zinner)
> getephem -o 1000032
Jun 16, 2008 11:12:30 AM herschel.mps.tools.horizons.HorizonsManager
INFO: A unique SPK-ID was requestedJun 16, 2008 11:12:30 AM
Jun 16, 2008 11:12:30 AM herschel.share.util.Configuration <init>
INFO: Build number is 1627
INFO: Sending email to horizons@ssd.jpl.nasa.gov for spkId= 1000032
INFO: Starting ....
INFO: Connected to scimail.esac.esa.int as hers_ephem
INFO: Default folder:
INFO: Going into folder: INBOX
INFO: Waiting for incoming mails from horizons ...
INFO: Received multiple comet apparitions for a requested SPK-ID...
resubmitting
INFO: possibleSpkId=900245
INFO: Resending an email for: 900245
INFO: Sending email to horizons@ssd.jpl.nasa.gov for spkId= 900245
INFO: Saving output file:
/home/pgomez/opt/mps_files/mpsdata/horizons/20080516_111232/1000032
INFO: Email reception completed for this run.

A number of remarks about this example (marked in the above log in bold):
●

Although SPK-ID is supposed to be the unique reference for SSOs, there are
several objects (prominent periodic comets as the one in the example) whose
ephemeris are considered different for each apparition. This is recognized by the
tool and the email is resent with the last apparition ID (9xxxxx). The returning
ephemeris is stored with the original SPK-ID though.

●

Note that the ephemeris is stored in hcss.mps.ssodir in a directory named with
the yyyymmdd_hhmmss format. This will create a different directory for each
tool run.
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For a range of objects
The system sends the mails for those objects defined in the system6 in a range:
> getephem -r 1000017 1000094
For all defined objects
The system sends the mails for all the objects configured in the system
> getephem -a
10.1.3 FTS conversion
This tool wraps the ephemeris files in the latest directory created by the previous tool and
converts it to the FTS format, see [RD8]. The format of the resulting file is that described
in [RD8]. Several executions of the tool generate files with incremented version.
Tool execution
> wrap_fts EPHEM
INFO: Inspecting directory: /home/pgomez/opt/mps_files/mpsdata/horizons
/home/pgomez/opt/mps_files/mpsdata/horizons/20080516_111232
INFO: Final File: 01000032_0001_20080031120000_20130021120000.SSOL
INFO: Creating tar file:
/home/pgomez/opt/mps_files/mpsdata/transfer/files/SSOL_HSCSDA_D20080616_0
001_0000.HERS

Note that there are sent only those objects configured in the system ( in the file
mps/tools/horizons/resources/Ephemeris_SPKIDs.properties)
6

